## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Using the Software</td>
<td>1</td>
</tr>
<tr>
<td>Supported Applications</td>
<td>1</td>
</tr>
<tr>
<td>Installing Visual Basic for Applications (VBA) for CorelDRAW 10</td>
<td>1</td>
</tr>
<tr>
<td>Installation and Setup</td>
<td>2</td>
</tr>
<tr>
<td>Recommended System Requirements</td>
<td>2</td>
</tr>
<tr>
<td>Before You Install the Software</td>
<td>2</td>
</tr>
<tr>
<td>Installing the Software (Windows)</td>
<td>2</td>
</tr>
<tr>
<td>Uninstalling the Software (Windows)</td>
<td>2</td>
</tr>
<tr>
<td>Installing the Software (Macintosh)</td>
<td>3</td>
</tr>
<tr>
<td>Uninstalling the Software (Macintosh)</td>
<td>3</td>
</tr>
<tr>
<td>Creating an Output Device Setup</td>
<td>3</td>
</tr>
<tr>
<td>Using Preference Manager</td>
<td>3</td>
</tr>
<tr>
<td>Saving a Set of Preferences</td>
<td>3</td>
</tr>
<tr>
<td>Loading a Set of Preferences</td>
<td>3</td>
</tr>
<tr>
<td>Restoring the Software to its Original State</td>
<td>4</td>
</tr>
<tr>
<td>Exiting Preference Manager</td>
<td>4</td>
</tr>
<tr>
<td>Creating the Job in the Design Application</td>
<td>5</td>
</tr>
<tr>
<td>Guidelines for Creating Your Design</td>
<td>5</td>
</tr>
<tr>
<td>Accessing the Cut/Plot Dialog</td>
<td>5</td>
</tr>
<tr>
<td>Entering Numerical Values</td>
<td>6</td>
</tr>
<tr>
<td>Using Built-In Mathematical Operations</td>
<td>6</td>
</tr>
<tr>
<td>Automatic Application of Entered Values and Arithmetic</td>
<td>6</td>
</tr>
<tr>
<td>Setting Job Properties</td>
<td>7</td>
</tr>
<tr>
<td>Setting General Tab Properties</td>
<td>7</td>
</tr>
<tr>
<td>Setting Layering Tab Properties</td>
<td>8</td>
</tr>
<tr>
<td>Setting Panel Tab Properties</td>
<td>10</td>
</tr>
<tr>
<td>Setting Advanced Tab Properties</td>
<td>14</td>
</tr>
<tr>
<td>Sending Jobs to Cutting Master 2</td>
<td>15</td>
</tr>
<tr>
<td>Outputting Jobs from Cutting Master 2</td>
<td>16</td>
</tr>
<tr>
<td>Basic Elements of Cutting Master 2</td>
<td>16</td>
</tr>
<tr>
<td>Column Headings</td>
<td>16</td>
</tr>
<tr>
<td>Toolbar</td>
<td>16</td>
</tr>
<tr>
<td>Setting Application Preferences</td>
<td>16</td>
</tr>
<tr>
<td>Creating an Output Device Setup in Cutting Master 2</td>
<td>17</td>
</tr>
<tr>
<td>Creating Your First Output Device Setup</td>
<td>17</td>
</tr>
<tr>
<td>Changing the Output Device Setup</td>
<td>18</td>
</tr>
<tr>
<td>Editing Output Device Settings</td>
<td>18</td>
</tr>
<tr>
<td>Outputting a Test Cut Job</td>
<td>19</td>
</tr>
<tr>
<td>Outputting Jobs from Cutting Master 2</td>
<td>19</td>
</tr>
<tr>
<td>Saving a Job to a File</td>
<td>19</td>
</tr>
<tr>
<td>Loading a Saved Job from a File</td>
<td>19</td>
</tr>
<tr>
<td>Sending Jobs to the Cutter</td>
<td>20</td>
</tr>
<tr>
<td>Aborting the Processing of a Job</td>
<td>20</td>
</tr>
<tr>
<td>Deleting Jobs</td>
<td>20</td>
</tr>
<tr>
<td>Contour Cutting Using Cutting Master 2</td>
<td>21</td>
</tr>
<tr>
<td>Designing a Job for Virtual Hybrid Output</td>
<td>21</td>
</tr>
<tr>
<td>Adding Registration Marks to the Print Job</td>
<td>21</td>
</tr>
<tr>
<td>Adding Registration Marks Automatically</td>
<td>22</td>
</tr>
<tr>
<td>Replacing a Rectangle with Registration Marks</td>
<td>23</td>
</tr>
<tr>
<td>Removing Registration Marks</td>
<td>23</td>
</tr>
<tr>
<td>Outputting the Printed Parts of the Design</td>
<td>23</td>
</tr>
<tr>
<td>Loading the Printed Media into Your Cutter</td>
<td>23</td>
</tr>
<tr>
<td>Outputting the Contours to Your Cutter</td>
<td>24</td>
</tr>
<tr>
<td>Index</td>
<td>25</td>
</tr>
</tbody>
</table>
Software License Agreement

Carefully read the following terms and conditions.

This is a legal agreement between you, the end user (either an individual or an entity), and Scanvec Amiable, Inc. If you do not agree with the following, you should promptly return the package. Use of this program indicates your acceptance of the terms and conditions stated below.

The enclosed computer program "Software" is licensed, not sold, to you by Scanvec Amiable, Inc., for use on a non-exclusive, non-transferable basis, only under the following terms, and Scanvec Amiable, Inc., reserves any rights not expressly granted to you. You may not disclose to any third party any confidential information concerning the Software or Scanvec Amiable, Inc. or use such confidential information to the detriment of Scanvec Amiable, Inc...

1. License.

This software is protected by the United States Copyright Law and International Treaty Provisions. Therefore, you must treat the Software just as you would any other copyrighted material, such as a book. This license allows you to:

(a) Make one copy of the Software in machine readable form; provided that such a copy of the original may be used solely for backup purposes. As an express condition of this License, you must reproduce on each copy of the Scanvec Amiable, Inc., copyright notice and any other proprietary legends on the original copy supplied by Scanvec Amiable, Inc.

(b) Transfer the Software and all rights under this License to another party together with a copy of this License and all written materials accompanying the Software provided you give Scanvec Amiable, Inc., written notice of the transfer and the other party reads and agrees to accept the terms and conditions of this License.

(c) Use this Software on a single computer only, but may transfer it to another computer as long as it is used on only one computer at a time. "In Use" constitutes being loaded onto either temporary (i.e., RAM) or permanent memory (e.g., hard disk, CD-ROM or other storage device) of a computer.

2. Restrictions.

You may NOT distribute copies of the Software to others or electronically transfer the Software from one computer to another over a network. You may not decompile, reverse engineer, disassemble or otherwise reduce the Software to a human perceivable form. You may not modify, adapt, transfer, rent, lease, loan, resell for profit, distribute, network or create derivative works based upon the software or any part thereof.

3. Termination.

This License is effective until terminated. This License will terminate immediately if you fail to comply with any of its provisions. Upon termination, you must return the Software, and all copies thereof, to Scanvec Amiable, Inc., and you may terminate this License at any time by doing so.


You agree that neither the Software nor any direct product thereof will be transferred or exported, directly or indirectly, into any country prohibited by the United States Export Administration Act or any international export laws and the restrictions and regulations thereunder, nor will it be used for any purposes prohibited by the Act or laws.

5. Warranty Disclaimer, Limitation of Remedies and Damages.

In no event will Scanvec Amiable, Inc., be liable for any damages, including infringement, lost data, lost profits, cost of cover or other special, incidental, consequential or indirect damages arising from the use of the program however caused and on any theory of liability. This limitation will apply even if Scanvec Amiable, Inc., or an authorized dealer or distributor has been advised of the possibility of such damage. SCANVEC AMIABLE, Inc. MAKES NO WARRANTY, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, AND DISCLAIMS, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Scanvec Amiable, Inc., does not warrant any drivers for plotting, scanning or either devices. These drivers are provided for our customers as a service only, and were developed using information provided to us at the time by the equipment manufacturers.

Scanvec Amiable, Inc., is not responsible for any typographical errors in the software or in the documentation.


If you are a U.S. Government end-user, this License of the Software conveys only "RESTRICTED RIGHTS," and its use, disclosure, and duplication are subject to Federal Acquisition Regulations, 52.227-7013(c)(1)(ii). This License will be construed under the laws of the State of Pennsylvania, except for that body of law dealing with conflicts of law, if obtained in the U.S., or the laws of jurisdiction where obtained, if obtained outside the U.S. If any provision of this License is held by a court of competent jurisdiction to be contrary to law, that provision of this License will remain in full force and effect.

© Copyright 2010 by Scanvec Amiable, Inc. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system or transmitted, in any form or by any means, electronic, mechanical, photocopy, recording or otherwise, without the prior written permission of the publisher. Printed in the United States of America. The information in this manual is subject to change without notice and does not represent a commitment on the part of Scanvec Amiable, Inc.

Acrobat® Reader Copyright© 1987-2010 Adobe Systems Incorporated. All rights reserved. Adobe and Acrobat are trademarks of Adobe Systems Incorporated which may be registered in certain jurisdictions. PostScript® software Copyright© 1984-1998 Adobe Systems Incorporated. All rights reserved.

Flexi, FlexiFAMILY, FlexiSIGN-Pro, FlexiSIGN Plus, FlexiEXPERT, FlexiSIGN, FlexiLETTER, FlexiDESIGNER, FlexiCUT, FlexiENGRAVE, PhotoPRINT Server, PhotoPRINT, PhotoPRINT SE, EnRoute-Pro, EnRoute Plus, EnRoute, EnRoute-Machine Shop, and/or other Scanvec Amiable products referenced herein are either trademarks or registered trademarks of Scanvec Amiable, Inc. Illustrator is a
Introduction

Cutting Master 2 is a program that allows you to output directly from your design application to a cutter.

It consists of two parts:

- The Cut/Plot plug-in that allows you to set job properties for the cut job from within your design application and sends the job to Cutting Master 2.
- The Cutting Master 2 program that receives the job from the Cut/Plot plug-in and outputs it to the cutter.

Using the Software

To send a job to a cutter using Cutting Master 2:
1. Create the job in the design application.
2. If desired, add registration marks to your design.
3. Open the Cut/Plot dialog.
4. Adjust the job properties in the Cut/Plot dialog.
5. Send the job to Cutting Master 2.
6. Use Cutting Master 2 to output the job to the cutter.

Supported Applications

On Windows, Cutting Master 2 supports the following design applications:

- Corel CorelDRAW 10, 11, 12, X3, X4, X5
- Adobe Illustrator 8, 9, 10, CS, CS2, CS3, CS4, CS5

On Macintosh OS X, Cutting Master 2 supports the following design applications:

- Adobe Illustrator 10, CS, CS2, CS3, CS4, CS5

Installing Visual Basic for Applications (VBA) for CorelDRAW 10

VBA automatically installs for CorelDRAW 11, 12, X3, X4 and X5. When you install CorelDRAW 10 through the typical installation, VBA does not automatically install. You must install VBA in order to run the Cut/Plot feature of your software.

If you need to install CorelDRAW and VBA:
1. When installing CorelDRAW, select Custom Setup.
2. From the list of components, select Visual Basic for Applications 6.0 & IE 5.
3. Continue with regular installation.

If you need to install VBA only:
1. Insert the CorelDRAW CD.
2. From the Corel Setup Wizard, select Add New Components.
3. From the list of components, select Visual Basic for Applications 6.0 & IE 5.
Installation and Setup

Before you begin installing the software, read the hardware requirements below. For optimal performance we suggest that your system meet the recommended requirements. As with all computer software, systems with faster processors, more RAM, and greater amounts of storage space allow you to work with larger files and keep your processing time to a minimum.

Recommended System Requirements

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Pentium III 600 MHz</td>
<td>G4,G5,Intel CPU</td>
</tr>
<tr>
<td>RAM</td>
<td>256 MB</td>
<td>100 MB</td>
</tr>
<tr>
<td>Install Space</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 7,Vista, XP, 2000</td>
<td>OSX 10.2 or greater</td>
</tr>
<tr>
<td>Video</td>
<td>800x600 resolution monitor with 16 bit color</td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>4x CD-ROM or DVD Drive</td>
<td>Available Port for Output Device</td>
</tr>
<tr>
<td></td>
<td>Internet Connection</td>
<td></td>
</tr>
</tbody>
</table>

Before You Install the Software

Before you install the software, you should do the following:

- Install all of your design applications.
- Install any additional drivers that are necessary for your cutters, such as USB drivers.
- Set your cutter to operate in GPGL mode. See your cutter documentation for details.

Installing the Software (Windows)

To install Cutting Master 2:

1. Uninstall any previous version of the software.
2. Insert the Installation CD.
3. Select a language and then click OK.
4. Select the product and language to be installed and then click Next.
5. On the Welcome screen, click Next.
6. Read the Software License Agreement and click Yes to accept.
7. Select the components of the software that you want to install. You may also change the folder the software will be installed into. Click Next.
8. Select the Start menu folder where the shortcut for the software will appear. By default, a new folder will be created for the product. Click Next.
9. Select whether additional shortcuts for the software will be created:
   a. Check Install to desktop to install a shortcut for the software on the desktop.
   b. Click Next.
10. Click Next to begin installing the software.
11. If you have Adobe Illustrator installed, you will be prompted for the location of the Plug-ins folder for each version of Illustrator you have installed.
   a. If necessary, click Browse and select the folder location.
12. Click Yes to clear the preferences.

Uninstalling the Software (Windows)

1. Exit Cutting Master 2 by selecting Exit from File menu.
2. In the Windows Control Panel, double-click the Add or Remove Programs icon.
3. Select Cutting Master 2 from the list and click the Change/Remove button.
4. In the Welcome screen, select Remove and click Next.
5. Click Yes to uninstall the software.

**Installing the Software (Macintosh)**

Follow these steps to install the software:
1. Insert the Installation CD.
2. Double click the Installer icon.
3. Select a language and then click OK.
4. Select the product and language to be installed and then click OK.
5. Read the Software License Agreement and click Accept.
6. Click Next.
7. Select the Install Location and click Install.
   - The software installs. Click Stop to halt installation.
8. Click Yes to clear the preferences.
9. Click OK.
10. Click Quit.

**Uninstalling the Software (Macintosh)**

1. Exit Cutting Master 2 by selecting Quit from the application menu.
2. In the Cutting Master folder, double-click Uninstall.
3. Click OK.

**Creating an Output Device Setup**

The first time that you run Cutting Master 2, you will be prompted to create an output device setup. See “Creating an Output Device Setup in Cutting Master 2” page 16 for details.

---

**Using Preference Manager**

Preference Manager is a utility that allows you to save all of the settings in the software to a file, including all output device setups and all application preferences.

You cannot load a set of preferences while either the design software or Cutting Master 2 is running. You can save preferences at any time.

**Saving a Set of Preferences**

To save the current set of preferences to a file:
1. Run Preference Manager.
2. Click Save.
3. Type the name for the set of preferences in the field and click OK.

**Loading a Set of Preferences**

To reload a previously saved set of preferences:
1. Exit the software.
2. Run Preference Manager.
3. Select the set of preferences you want to load.
4. Click **Load**.

**Restoring the Software to its Original State.**

The default settings for the software are stored in the **Factory Defaults** set of preferences. Restoring the software to its default state may be particularly helpful when troubleshooting any problems you may encounter with Cutting Master 2.

- Loading this set of preferences will remove the output device setup in Cutting Master 2.

To clear the preferences stored in your system:

1. Exit the software.
2. Run **Preference Manager**.
3. Select **Factory Defaults**.
4. Click **Load**.

**Exiting Preference Manager**

To exit Preference Manager, click **Exit**.
Creating the Job in the Design Application

The first step in outputting a job using Cutting Master 2 is to create the job in your design application.

Guidelines for Creating Your Design

When creating a job, remember the following guidelines:

- Convert all bitmap graphics into vector objects. Cutting Master 2 can only output vector objects.

- Objects cannot have patterned fills, bitmap fills, lens effects, gradients, or other custom fill types. Any objects with these fill types will be ignored by Cutting Master 2, and will not appear in the Cut/Plot dialog.

- Use colors or layers to separate objects that you want to output at different times. You can then use the Layering tab of the Cut/Plot dialog to choose which colors or layers will be output.

- There is no need to make duplicate copies of your design in the design application. Cutting Master 2 can easily output duplicates of any design, and can even place multiple copies on the same page.

- Don’t worry about objects of the same color that overlap. The Auto-Weld feature can automatically merge overlapping objects together.

- If you need to make multiple cutting passes, you can select the number of passes in the Advanced tab of the Cut/Plot dialog. There is no need to stack up multiple copies of an object to force multiple cutting passes.

Accessing the Cut/Plot Dialog

Once you have created your job, the next step is to open the Cut/Plot dialog.

To access the Cutting Master 2 Cut/Plot dialog:

- If you are using Adobe Illustrator, from the File menu, select Cutting Master 2 then Cut/Plot.

- If you are using CorelDRAW, select Cut/Plot from the Corel Application Launcher. The Corel Application Launcher is a list in the standard toolbar that lets you launch other applications from within CorelDRAW. It uses the following icons, depending on your version of CorelDraw:

CorelDRAW 10
CorelDRAW 12 & X3
CorelDRAW 11
CorelDRAW X4 & X5
Entering Numerical Values

Cutting Master 2 supports a number of unique features that make it easier to enter numerical values.

Using Built-In Mathematical Operations

The software is able to perform a number of calculations whenever a numerical value is being entered.

Automatic Unit Conversion

If you enter a value using a different unit of measurement than the default unit, the software will automatically convert the value to the default unit.

For instance, if your default unit is inches, you can enter a value of 1 ft, and the software will convert the measurement to 12 in.

Supported units are:

<table>
<thead>
<tr>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>in, &quot;</td>
</tr>
<tr>
<td>ft, '</td>
</tr>
<tr>
<td>mm</td>
</tr>
<tr>
<td>cm</td>
</tr>
<tr>
<td>m</td>
</tr>
<tr>
<td>pt</td>
</tr>
</tbody>
</table>

Calculation of Ratios

If you enter a ratio in the format A:B, the software will scale the previous value in the field by the ratio entered.

For instance, if a value is set to 12, and you enter 2:3, the new value will be 8.

Calculation of Percentages

If you enter a percentage in the format X%, the software will scale the previous value in the field by the percentage entered.

For instance, if a value is set to 10, and you enter 90%, the new value will be 9.

Simple Arithmetic Operators

If you enter a simple arithmetic expression, the software will calculate the result of the expression and enter that value in the field.

The available arithmetic operators, in order of precedence, are:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
</tbody>
</table>

For example, if you enter 1/8, the value 0.125 will be calculated.

Operator precedence determines the order in which the arithmetic operations will be calculated when more than one operation is specified. In the previous list, operators are listed from top to bottom in order of operator precedence. For instance, if you enter 6/2*3, the software will calculate 6/2 first then multiply the result by 3, yielding a result of 9.

Automatic Application of Entered Values and Arithmetic

Once you enter a numerical value, ratio, or arithmetic expression in a numerical field, the software will automatically apply that value after a brief delay.
Setting Job Properties

The following controls are available on all tabs of the Cut/Plot dialog:

- **Properties**: Click to adjust the setup properties. See “Editing Output Device Settings” page 18 for details.
- **Click to start Cutting Master 2.**
- **Click to select the Select tool.** (This tool is selected by default most of the time)
- **Click to select the Zoom tool.** Click and drag in the job preview pane to select an area of the design to zoom in on. For Windows, hold the CTRL key and click to zoom out. For Macintosh, hold the Option key and click to zoom out.
- **Click to select Zoom to Width.** The preview pane will automatically zoom in or out so that the entire width of the media is displayed.
- **Click to select Zoom to All Objects.** The preview window will zoom in or out so that all of the objects in the design are displayed.
- **Reset**: Click to return job properties to their default settings.
- **Send**: Send the job to Cutting Master 2 with the current settings.
- **Done**: Close the Cut/Plot dialog and return to the design application.

Setting General Tab Properties

The General tab allows you to specify the size of media, size of the job and the location of your output on the media.

The following settings are available:

- **Media Size**: The size of the media loaded into your output device. Select from one of the preset sizes, or specify unique dimensions below.
- **Poll Size**: polls the size of the media loaded in the cutter. This feature only works if the device and port support bi-directional communications.
- **Job Size**: Choosing one of these options allows you change the output size and orientation of the page.
  - The job's width and height.
  - The job's width and height as a percentage of the original.
**Fit to Media**  Scales the job proportionally so that it is as large as possible while still fitting within the cuttable area of the output media.

**Proportional**  When this option is selected, the height and width of the job are increased or decreased together to keep the original proportions intact.

**Position**  These settings change the position of the job on the media.

- The distance between the job and the right and bottom margins of the cuttable area. You can also change these settings by dragging the job across the page in the preview pane.
- **Interactive**: moves the cutter as you change the position of the job on the preview area.
- **Show me**: draws a bounding box of the job without lowering the tool.
- Places the job at the specified distances from the lower and right edges of the cuttable area of the output media.
- Centers the job along the width of the cuttable area.
- Centers the job in the middle of the cuttable area. Only available for sheet material.
- Rotates the image on the media in 90-degree increments. Click the button until you achieve the desired orientation.
- Flips the selected image on the vertical axis, so that your image will be mirrored when output.

**Selection**  The number of copies to be output.

**Hold in list**  The amount of space that will exist between the various tiles and/or copies that will be output as part of the job.

**Use document origin**  If not checked, left bottom point of the bounding box of selected objects becomes origin of plotter. If checked, document origin of Illustrator or CorelDRAW becomes origin of plotter. Positions of objects from document origin are kept positions from the plotter origin.

- Note: Document origin of Illustrator or CorelDRAW is the point (0,0) of the ruler.

### Setting Layering Tab Properties

The layering tab allows you to assign different cutting parameters to different color or layers in your cutting job. You can cut one color slower than another color, for instance.

The following settings are available:
By color/By layer
Orders your output by color, or by layer. “Layer” refers to layers in the design application, not overlapping layers of vinyl.

- If you choose By color, all objects with the same color will be cut at the same time, unless Pause between colors/layers is checked. If you have overlapping objects of the same color, you will get overlapping contour cuts.
- If you chose By layer, the job will be cut one layer at a time. All objects in each layer will be cut at once, unless Pause between colors/layers is checked. If you have overlapping objects in a layer, you will get overlapping contour cuts.

Pause between colors/layers
If checked, output will be paused between colors or layers. This allows you to load different colored vinyl into your cutter.
If cleared, the job will be sent as a single layer. The Single setting for all option will automatically be checked, and identical driver options will be used for the entire job. If weedlines are enabled, there will only be a single set of weedlines for the entire job.

Enable driver options
Check to set the following options in the software. If this option is not checked, the settings on the output device will be used instead.
Settings can be set individually for each color or layer by selecting the color or layer in the list then setting the options below (but see Single setting for all).

Single setting for all
If this option is checked, identical driver options will be used for all colors or layers.
If Pause between colors/layers is not checked, Single setting for all is automatically checked, and may not be cleared. This is because the job is automatically sent as a single layer when Pause between colors/layers is not checked.

Preset
Driver option presets allow you to save all of the driver options for a common type of job and reapply them in a single step. See “Working with Driver Option Presets” below, for details.

Condition
The cutter condition number. Numbers range from 1 to 8. See the documentation for your cutter for details on which numbers are valid.

Speed
Speed at which the cutting head or pen moves across the media.
Set to 0 to use the setting on the cutter.

Force
The amount of downwards force applied to the cutting head or pen.
Set to 0 to use the setting on the cutter.

Quality
The Quality setting really controls the maximum acceleration of the cutting head or pen. Lower settings produce higher quality, at the cost of increased cutting time.
Set to 0 to use the setting on the cutter.

Line Type
Select the line type.
The following line types are provided as standard:
1
2
3
4
5
6
7
8
9
You can also edit three custom line types. See “Editing Custom Line Types” page 10 for details.

Pitch
The length it takes for the line pattern to repeat when a line type other than solid is selected.

Size
Passes
Defines the number of times that the blade will cut the same path. Set this option if you are using thick or hard media that can’t be cut in a single pass.

Plotter Controller
If checked, Cutting Master 2 will send the current job to the Graphtec Plotter Controller application for output when the Send button is clicked. This option is only enabled if the setup is for a device that is supported by the Plotter Controller application. The device setup must use a USB connection. If Plotter Controller is not installed, this option will be disabled. See the Plotter Controller documentation for details on outputting jobs from that application.
When this option is checked, the following fields in the cut/plot dialog will be disabled:
- Job width
- Job height
Working with Driver Option Presets

Driver option presets allow you to save all of the driver options for a common type of job and reapply them in a single step.

Creating Presets

To save the current driver options as a new preset:

1. From the Preset list, select Save as.
2. Enter a name for the new preset.
3. Click OK.

Updating Presets

To update the currently selected preset with the currently selected driver options, from the Preset list, select Save.

Applying a Preset

To apply the driver options saved in a preset to the current job, select the preset from the Preset list.

Renaming a Preset

To rename a preset:
1. Select the preset you want to rename from the Preset list.
2. Select the Rename command from the Preset list.
3. Type in the new name and press OK.

Deleting a Preset

To delete a preset:
1. Select the preset you want to delete from the Preset list.
2. Select the Delete command from the Preset list.
3. Click Yes.

Editing Custom Line Types

To edit the custom line types:
1. Select Edit from the Line Type list.

2. Specify the three custom line types by listing the lengths of the line segments and spaces that make up the line:
   a The length of the first segment in the line.
   b The length of the space between line segments.
   c The length of the second and third line segments, if any. Custom 1 is made up of one repeating line segment, while Custom 2 has two segments that repeat in a pattern, and Custom 3 has three.

3. Click OK.

Setting Panel Tab Properties

The Panel tab allows you to split a job up into a number of
smaller tiles that are then output separately.

The following settings are available:

**Panel Size**

The panel is the part of the job that will be split up into tiles and output by the software. If the panel is reduced in size so that it does not cover the entire job, only the parts covered by the panel will be output.

- Shows the width and height of the panel. To adjust, enter a number or use the arrows.
- The size of the margin. The margin is the part of the panel that extends outside of the boundaries of the job.

**Selected Tile**

Selects which tile’s width and height are displayed in the fields below.

- Selects a tile to be edited. The selected tile is highlighted in the preview pane.
- Shows the width and height of the selected tile. To adjust, enter a number or use the arrows.

**Output**

If checked, the selected tile will be output with the rest of the job. If cleared, the tile is marked with a mesh overlay in the preview pane, and will not be output.

**All Tiles**

These settings apply to all tiles and help you quickly set up automatic tiles, of equal size.

- Selecting this option divides the job vertically into the number of columns specified. Each column will be of equal width.
- Selecting this option divides the job into the number of rows specified. All rows will be of equal height.
- If you know that you want tiles of a certain size, enter the values for the width and height of the tiles here. All tiles will be changed to the specified size.

**Overlap**

Specifies the amount of overlap between rows and columns. By overlapping, you can eliminate any gaps between the tiles when assembling the final output. Overlap is measured as the total amount two rows or columns overlap.

- Check to create an overlap on the vertical edges of tiles.
- Check to create an overlap on the top and bottom edges of tiles.
- The width of the overlap. Enter a negative number to create an offset between tiles.

**Locks the columns so that the tiles on a same column can be adjusted as a group.**
Locks the rows, so that the tiles on a same row can be adjusted as a group.

Locks both columns and rows, so that the entire columns or rows can be adjusted as a group.

**Auto-tile:** A tile will automatically be created that includes all selected objects. If no objects are selected, all of the objects in the design will be included. If the design is too large to fit on the selected media, it will automatically be tiled so that each tile is the maximum possible size. Auto-tile does not attempt to tile the entire page, just the design or the selected objects.

**Tile to Border:** The entire design page is automatically tiled. If the page is too large to fit on the selected media, it will be tiled so that each tile is the maximum possible size.

### Dividing a Job Into Tiles

The job starts as a single large tile that covers the entire job. This tile is selected by default.

To divide the job into multiple tiles, reduce the width and/or height of the first tile using the fields in the **Selected Tile** section. New tiles will automatically be created to cover the exposed areas of the job.

For instance, to divide a 30x25 job into two vertical tiles, set the field to 15, reducing the size of the first tile to 15x25. A second 15x25 tile will automatically be created.

### Dividing a Job into Uniform Rows and Columns of Tiles

To divide the job into a specified number of uniform rows and columns of tiles:

1. Check or to tile the job vertically or horizontally.
2. Enter the number of columns of tiles in the field.
3. Enter the number of rows of tiles in the field.
4. Set the amount of overlap between the tiles in the field.

### Dividing a Job into Uniform Tiles of a Specified Size

To divide the job into uniform tiles of a specified size:

1. Check and to set all tiles in the job to be of the specified size.
2. Set the and fields to the width and height desired for the tiles.
3. Set the amount of overlap between the tiles in the field.
If the specified tiles do not cover the job evenly, the tiles at the top and right edges will be made small enough to fit in the gap.

**Selecting a Tile**

To select a tile, either click on the tile in the preview pane, or select the tile using the field in the *Selected Tile* section of the *Tile* tab.

**Editing Tiles**

To edit the size of the selected tile, change the values in the and fields.

You can also resize tiles by dragging their edges in the Preview Pane.

If you drag the edges of the panel over so that part of the job is exposed, a new tile will be created to cover the exposed area of the job. The exception to this is if you resize the panel using the cropping handles (see “Cropping a Job” page 14 for details).

**Preventing Tiles from Being Output**

To disable a tile and prevent it from being output with the rest of the job, do one of the following:

- Double-click on the tile in the preview pane.
- Right-click on the tile in the preview pane.

Disabled tiles are marked with a hash pattern.

To make a disabled tile able to be output again, double-click or right-click the disabled tile a second time.

One tile in each job must always be enabled. If you try to disable all of the tiles, one of the other tiles will become enabled again.
Cropping a Job

To crop out part of a job so that it will not be output:

1. Open the Job Properties dialog for the job.
2. Select the Tiling Preview view of the job.
3. Drag the red cropping handles so that the unwanted parts of the job are cropped out.

Cropped-out areas of the job will not be output.

You can also crop a job by reducing the panel size using the \( \text{Width} \) and \( \text{Height} \) fields in the Panel Size section of the Tile tab.

Removing All Tiling and Cropping

To remove all tiling and cropping and make the job one piece again, click on the Reset button.

\( \text{Advance after plot} \)

Advances the media after the job has been output and resets the origin.

\( \text{Cross cut} \)

If checked, after a job has been cut, the cutter will slice across the output media above the job, separating it from the rest of the media still in the cutter.

For a multi-page job, the cutter will do a cross-cut after each page in the job.

\( \text{Additional advance} \)

Advances the media an additional amount after the job has been output.

\( \text{Weed Border} \)

Cuts a border with the specified Panel margin around all objects in the selected color and layer.

The weed border is always a solid line, regardless of any settings in the Layering tab.

\( \text{Panel Margin} \)

The panel margin used for the weed border.
Horizontal weed lines
Add weedlines between lines of text (or objects).

Vertical weed lines
Add weedlines between characters (or objects).

Optimize cutting order
Select the order in which objects in the design will be cut:
- None: The objects are cut or plot in the order they were created.
- Speed Priority: The objects will be cut in an order that maximizes cutting speed.
- Restrict Media Movement: The objects will be cut in an order than minimizes the amount that the media has to move.

Auto-weld
Removes overlapping areas of objects that have the same color.

Convert strokes to outlines
Selects whether the strokes will be cut separately as an object.

Cut page crossing
When split up the output to a number of pages, indicate cut or not the page crossings. If not checked, doesn’t cut the page crossing. If checked, cut the page crossing.

If not checked

If checked

Units
Specifies the units that will be used for measurements.

After output
Sets what will be done with the file after it is output. Select either Delete or Hold.

Step size
The number of steps per unit length currently set on your cutter.

Use Registration Marks
Can be used to align a contour cut with the printed output.

X and Y copies
Sets the number of copies to add along the X or Y axis.

Spacing
Sets the distance between copies.

X and Y offset
Compensates for the offset of the cutting position that can occur when cutting thick media.

Sending Jobs to Cutting Master 2

To send the current job to Cutting Master 2 for output, click the Send button in the Cut/Plot dialog. To exit the Cut/Plot dialog, click Done.

Once sent to Cutting Master 2, the job will immediately be output, unless the Hold in List option on the General tab of the Cut/Plot dialog is checked. If Hold in List is checked, the job must be output manually. See “Outputting Jobs from Cutting Master 2” page 19 for details.

Once output, the job will either be deleted, or held in the queue, depending on the After Output setting in the Advanced tab of the Cut/Plot dialog. See “Setting Advanced Tab Properties” page 14 for details.
Outputting Jobs from Cutting Master 2

Basic Elements of Cutting Master 2

The following are the basic elements of Cutting Master 2:

Column Headings

Note the column headings in the job area:

- **Job Name**: The file name of the job.
- **Status**: The current status of the job.
- **Copies**: The number of copies to be output.
- **File Type**: The type of job.
- **Color**: The color specified for the material. If multiple colors are specified, this field will read *Multiple*.

Toolbar

A toolbar is located at the top of the main window. It contains tools for the most commonly used functions.

To show or hide a toolbar, select **Toolbar** from the **View** menu.

The toolbar functions are:

- **Add Job**: Adds a job to the selected output device.
- **Save As**: Saves the selected job to a file.
- **Send Job**: Sends the selected job to the output device.

Setting Application Preferences

To set application preferences, from the **Edit** menu select **Preferences**.

The following settings are available:

- **Units**: The units of measurement displayed.
- **Precision**: The degree of precision to use with measurements.
Creating an Output Device Setup in Cutting Master

The output device setup provides the link between the software and your output device. It contains the following information:

- The type of output device being used.
- The method used to communicate with the device.

Creating Your First Output Device Setup

When you start the software for the first time, you are prompted to create your first output device setup:

1. Select the Manufacturer and Model Name of the output device from the list.
2. Click Next.
3. Edit the Setup name of the device.
4. Click Next.
5. Select the Port the output device uses for communication. If necessary, edit the communications settings for the chosen port.
6. Click Finish.
Changing the Output Device Setup

The software allows only one output device setup to be in use at any given time. Creating a new setup will eliminate the existing one.

To change the output device setup, from the Setup menu, select Change Setup.

The steps to create the new setup are the same as the ones for the original setup.

Editing Output Device Settings

To edit the properties associated with the output device setup, from the Setup menu, select Setup Properties.

Job Workflow Tab

The Job Workflow tab displays information about the output device.

Communication Tab

The Settings section of this tab changes depending on the port used to connect to the output device. Ports are listed in order of popularity for each device. Only the ports that are usable by the output device are listed.

The standard port for the device is selected by default. Some of the port settings may still need to be entered or edited, however.

Port

Select the port to which the cutter is connected. The port list is limited to the ports that are actually present on your computer and usable with your output device.

LPT

Parallel port is the most common method to connect cutters to the computer. The following settings are available:

Transmission buffer

The size of the transmission buffer in bytes

Check port state before sending

If checked, the software will send a data packet to the cutter to test if the cutter is connected before beginning to cut the job.

Use standard LPT driver

Whenever possible, the software uses a custom LPT driver to increase the performance of the LPT port. If checked, the software will use the standard Windows LPT driver instead. Performance will be diminished, but reliability may be enhanced.

The following settings are enabled when the custom driver is in use:
Mode

Use **ECP** (Enhanced Capabilities Mode) for the fastest possible transmission speed. **EPP** (Enhanced Parallel Port) is not as fast, but may be more compatible.

**ECP** uses **DMA**

Using DMA with ECP can increase the maximum bit rate from 2 mbps to 4 mbps.

**Yield if device is busy**

If checked, the software will release the extra system resources used by the custom driver while the output device is busy. This may aid overall performance.

**USB**

USB drivers are provided with output devices that support them. Please make sure the proper drivers are installed when using these ports.

**COM**

Serial communications port. This port is only supported by cutters.

In addition to the standard serial port controls for bits per second, data bits, parity, stop bits and hardware/software flow control, there are checkboxes which enable/disable the following wires:

- **DTR** Data Terminal Ready
- **DSR** Data Set Ready
- **RTS** Request To Send
- **CTS** Clear To Send
- **DCD** Data Carrier Detect

**TCP/IP**

Transmission Control Protocol / Internet Protocol

---

**Outputting a Test Cut Job**

The software allows you to output test cutting jobs to appropriate output devices, to make sure everything is functioning properly.

To output a test cut job, from the **Setup** menu, select **Test Cut**.

**Outputting Jobs from Cutting Master 2**

If the **Hold in list** box in the General tab of the Cut/Plot dialog is not checked, jobs that are sent to Cutting Master 2 will be output automatically as soon as they are received.

If **Hold in list** is checked, the job will stay in the queue until you output it manually.

**Saving a Job to a File**

To save a job to a .PLT file, do one of the following:

- Select the job and from the **File** menu, select **Save As**.
- Select the job, then click on the **Save As** button in the toolbar.
- Right-click the job and select **Save As** from the context menu.

**Loading a Saved Job from a File**

To load a previously-saved job from a file:

1. From the **File** menu, select **Add Job**.

2. Select the file to be added.
3. If you want to copy the file to the local job folder, check Copy to job folder.

   If the job is on removable media or a network drive, copying it to a local folder will allow you to process the job after removing the media or disconnecting from the network.

4. Click Add.

**Sending Jobs to the Cutter**

To send a job to the cutter, do one of the following:

- Select the job and from the File menu, select Send.
- Select the job, then click on the Send button in the toolbar.
- Right-click the job and select Send from the context menu.

**Cutting a Job on a Cutter with Automatic Alignment**

To cut a job on an automatically aligned cutter:

1. Align the cutting head over the first automatic registration mark (lower right if not marked) using the controls on the front panel of the cutter.
2. Click OK to cut the contour.

**Aborting the Processing of a Job**

To abort the processing of a job while it is being cut, do one of the following:

- Select the job and from the File menu, select Abort.
- Select the job, then click on the Abort button in the toolbar.
- Right-click the job, then select Abort from the context menu.

If a job is aborted while being output, its status freezes at 0%.

---

**Deleting Jobs**

To delete a job, do one of the following:

- Select the job and press the Delete or Backspace key on your keyboard.
- Select the job and from the Edit menu, select Delete.
- Select the job, then click on the Delete button in the toolbar.
- Right-click the job, then select Delete from the context menu.
Contour Cutting Using Cutting Master 2

Cutting Master 2 allows you to use a cutter to cut a contour on printed output generated on a separate printer. This produces output similar to that of a hybrid printer/cutter device.

In order to cut a contour on a printed job, you need to do the following:
1. Create the design for the job in your design application.
2. Add registration marks that will allow Cutting Master 2 to align the cut contour with the printed job.
3. Output the printed parts of your design.
4. Load the printed media into your cutter.
5. Output the contour part of your design on your cutter.

Designing a Job for Virtual Hybrid Output

When designing a job for virtual hybrid output, the most important thing is that you should be able to separate the printed parts of the job from the cut parts of the job.

This can be done in two ways:
- By placing printed and cut elements on separate layers and then hiding the layers you do not want to output.
- By manually selecting the elements you want to print or cut, and then printing or cutting only the selected elements.

Of these two methods, we recommend using separate layers to isolate printed and cut elements, as this works much better with complex designs.

Adding Registration Marks to the Print Job

The Cutting Master 2 plug-in allows you to add registration marks to your design. These registration marks can then be used to align a contour cut with the printed output.

The registration marks are added in their own separate, locked layer of the design.

Do not change the name assigned to the layer containing the registration marks.

The registration marks must be printed out in order to be used for automatic alignment of a contour cut. The marks themselves will not be contour cut.

There are two ways to add registration marks to a design:
- Adding registration marks automatically.
- Adding a rectangle to the design and replacing it with registration marks.

If the design is changed or resized after the registration marks are added, you will need to remove the registration marks and add them again in order to properly indicate the new size of the job. Registration marks do not automatically update when a job is edited or resized.
**Adding Registration Marks Automatically**

If no object is selected, Cutting Master 2 will automatically add registration marks around your design.

To add registration marks to your design:

1. Open your job in the design application.
2. Access the Registration Marks dialog using one of the following methods:
   - In Adobe Illustrator, from the File menu, select Cutting Master 2 then Registration marks.
   - In CorelDRAW, select Registration Marks from the Corel Application Launcher. The Corel Application Launcher is a list in the standard toolbar that lets you launch other applications from within CorelDRAW. It uses the following icons, depending on your version of CorelDraw:

![CorelDRAW Icons]

3. Select the desired registration mark from the topmost list.

   - Graphtec Type 1 Automatic
   - Graphtec Type 2 Automatic
   - Graphtec Segment Area Type 1
   - Graphtec Segment Area Type 2

   *Graphtec Segment Area Type 1 and Graphtec Segment Area Type 2 marks are for CE5000 and FC7000 cutters only.*

4. Set the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>The unit of measurement.</td>
</tr>
<tr>
<td>Margin</td>
<td>The distance between the registration marks and the job.</td>
</tr>
<tr>
<td>Thickness</td>
<td>The thickness of the line that makes up the registration marks.</td>
</tr>
<tr>
<td>Length</td>
<td>The size of the registration marks, measured along one side.</td>
</tr>
<tr>
<td>Step</td>
<td>For the segment area type marks, the maximum distance between segment marks.</td>
</tr>
<tr>
<td>Direction</td>
<td>If checked, Segment Area type marks will be rotated 90 degrees.</td>
</tr>
<tr>
<td>Convert Rectangle</td>
<td>If checked, the registration marks will be placed around the border of the</td>
</tr>
<tr>
<td></td>
<td>selected rectangle. The rectangle will then be deleted, leaving only the</td>
</tr>
<tr>
<td></td>
<td>registration marks.</td>
</tr>
<tr>
<td>Align document origin with</td>
<td>If checked, left bottom point of the registration marks becomes (0,0) point</td>
</tr>
<tr>
<td>registration marks</td>
<td>of ruler of Illustrator or CorelDRAW. If add the registration marks without</td>
</tr>
<tr>
<td></td>
<td>check this check box, move the (0,0) point of ruler to left bottom point of</td>
</tr>
<tr>
<td></td>
<td>the registration marks before send the job to cutter.</td>
</tr>
<tr>
<td>Total size</td>
<td>The dimensions of the area covered by both the job and the registration</td>
</tr>
<tr>
<td></td>
<td>marks together.</td>
</tr>
</tbody>
</table>

5. Click OK.
Replacing a Rectangle with Registration Marks

If a rectangle is created in the design application, and is selected when the Registration Marks dialog is opened, Cutting Master 2 can use it as a bounding box for the registration marks. The registration marks will be placed on the border of the rectangle, and then the rectangle will be deleted, leaving only the registration marks.

To replace a rectangle with registration marks:
1. Open your job in the design application.
2. Draw the rectangle that you want to use as a bounding box.
3. Access the Registration Marks dialog (see previous instructions).
4. Make sure the Convert Rectangle option is checked.
5. Set any other desired options (see previous instructions).
6. Click OK.

Removing Registration Marks

To remove the registration marks, do one of the following:

- Repeat the procedure used to add the marks, but select None.
- Unlock and delete the layer that contains the registration marks.

Outputting the Printed Parts of the Design

To output the printed parts of the design:
1. Hide the layer or layers which contain the contour cuts.
2. Make sure the layer or layers which contain the printed part of the design are visible.
3. Use the standard printing function of the design application to send the job to your printer.

Loading the Printed Media into Your Cutter

Once the printed parts of the job have been output, allow the ink to dry (if necessary), then remove the media from the printer and load it into your cutter.

Be sure to orient the printed media so that the registration marks are not upside down, as this can cause problems.
Paper Moving Type

Load the media into the cutter then position the head over the registration mark located at the bottom right corner when facing the cutter.

Outputting the Contours to Your Cutter

To output the contour cut part of your design:

1. Hide the layer or layers that contain the printed part of your design.
2. Make sure the layer or layers that contain the contour cuts are visible.
3. Use the Cut/Plot dialog to send the output to Cutting Master 2.
4. Send the cut job to the cutter from Cutting Master 2, if necessary.
Index

aborting output .............. 16, 20
arithmetic operations ........ 6
automatic calculation ........ 6
automatic percent calculation ........ 6
automatic ratio calculation .... 6
blocking output of tiles ........ 13
calculating percentages ....... 6
calculating ratios ............. 6
calculation in place ............ 6
communication .................. 18
cropping jobs .................... 14
degree of precision ............ 14
deleting jobs ..................... 16
entering numerical values ..... 6
flip horizontal ................... 8
jobs
  aborting ......................... 20
  adding .......................... 16
  cropping ....................... 14
  deleting ......................... 16
  fitting to media ............... 8
  outputting ..................... 16
  positioning .................... 8
  rotating ......................... 8
  saving to file .................. 16
  setting job size ............... 7
  tiling ................................ 11
media size .......................... 7
mirroring .......................... 8
number of copies ................ 8
operator precedence .......... 6
panel size .......................... 11
parallel port settings ......... 18
percent calculation ............ 6
Plotter Controller ............. 9
ports ............................... 18
positioning jobs ............... 8
Preference Manager ........... 3
presets
  deleting ......................... 10
  editing ......................... 10
  renaming ....................... 10
preventing output of tiles ...... 13
queues
  column headings ............. 16
  ratio calculation ............ 6
  removing tiling .............. 14
  rotating jobs .................. 14
  separation between jobs ..... 8
serial port settings .......... 19
size of panel ..................... 11
size of media ..................... 7
size of media ..................... 7
specifying degree of precision ......... 16
system requirements ........ 2
tiling ............................. 11
  editing tiles ................... 13
  preventing output of tiles .. 13
  removing ....................... 14
  selecting a tile .............. 13
  uniform tiling ................ 12
toolbars ............................. 16
trimming jobs ................... 14
unit conversion .................. 6
uniform tiling ................... 12
units of measurement ........ 16
using the software .............. 1